Abstract

Install instructions for Oracle Linux, RHEL, SLES, VMware vSphere, and Foundation Software on HPE Integrity MC990 X Server.
Contents

Supported operating systems........................................................................................................... 5
  About installing the operating system software, Foundation Software, and optional features........... 5

Integrity MC990 X system software installation.............................................................................. 6
  Gathering installation materials and information.......................................................................... 6
  (Optional) Setting or changing an administrative password on the system console...................... 9
  Creating an installation environment.......................................................................................... 11
  Connecting to the server over the network (remote connection) using PXE................................. 12

Installing SUSE Linux Enterprise Server...................................................................................... 14
  Initiating SLES installation.......................................................................................................... 14
  Using SLES to partition the disk.................................................................................................. 15
  Configuring SLES network and miscellaneous settings................................................................ 19
  Installing Foundation Software (SFS) on SLES platforms.......................................................... 20

Installing Red Hat Enterprise Linux or Oracle Linux..................................................................... 23
  Initiating RHEL installation and partitioning the disk.................................................................. 23
  Configuring RHEL network and rebooting.................................................................................. 26
  Completing RHEL installation.................................................................................................... 29
  Installing the Foundation Software (SFS) on RHEL and Oracle platforms.................................. 30

Installing Oracle Linux software on an MC990 X server.............................................................. 33

Installing VMware vSphere on an HPE MC990 X Server............................................................ 35
  Introduction.................................................................................................................................... 35
  Supported VMware vSphere distributions.................................................................................. 35
  Installing the VMware vSphere image......................................................................................... 35
  Adding the boot entry.................................................................................................................. 38

Additional software features for the Integrity MC990 X system.................................................. 44
  Remote management through the ipmitool command............................................................... 44
  Security-Enhanced Linux (SELinux) configuration on RHEL platforms.................................... 44
  Configuring Security-Enhanced Linux (SELinux) on RHEL platforms....................................... 45
  Installation of debuginfo packages.............................................................................................. 46
  Installing debuginfo packages on RHEL platforms...................................................................... 46
  Installing debuginfo packages on SLES platforms....................................................................... 47
  Creating boot options.................................................................................................................. 49
  Crash dump files on an Integrity MC990 X system server on RHEL 7, SLES 12, and SLES 11 platforms.................................................. 51
  Creating a crash dump file on an Integrity MC990 X system server on RHEL 7, SLES 12, and SLES 11 platforms.................................................. 52
Connecting to an MC990 X system through a web browser and launching the JViewer console

About JViewer
Starting JViewer
Attaching virtual media to the MC990 X system
Booting from virtual media

Websites

Support and other resources

Accessing Hewlett Packard Enterprise Support
Accessing updates
Customer self repair
Remote support
Warranty information
Regulatory information
Documentation feedback
Notices

The information contained herein is subject to change without notice. The only warranties for Hewlett Packard Enterprise products and services are set forth in the express warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. Hewlett Packard Enterprise shall not be liable for technical or editorial errors or omissions contained herein.


Links to third-party websites take you outside the Hewlett Packard Enterprise website. Hewlett Packard Enterprise has no control over and is not responsible for information outside the Hewlett Packard Enterprise website.

Acknowledgements

Intel® and Intel Xeon® are trademarks of Intel Corporation in the U.S. and other countries.

Google® is a registered trademark of Google Inc.

Linux® is a registered trademark of Linus Torvalds in the U.S. and other countries.

Red Hat® is a registered trademark of Red Hat, Inc. in the United States and other countries.

SUSE LINUX is a registered trademark of Novell Inc.

Windows is a registered trademark of Microsoft Corporation in the United States and other countries.

NUMAlink® and NUMAflex® are trademarks or registered trademarks of Silicon Graphics International Corp. or its subsidiaries in the United States and/or other countries worldwide.
Supported operating systems

HPE Integrity MC990 X Server supports the following operating systems:

- RHEL 8.0
  - RHEL 7.2, 7.3, 7.4, 7.5, 7.6, 7.7
  - RHEL 6.8, 6.9, 6.10
- SLES 15 SP1
  - SLES 12 SP1, SP2, SP3, SP4
  - SLES 11 SP3, SP4
- Oracle Linux 7.3, 7.4, 7.5, 7.6, 7.7
  - Oracle Linux 8
- VMware vSphere 6.5
  - VMware vSphere 6.7 U3

About installing the operating system software, Foundation Software, and optional features

You can install the operating system and Foundation Software on an HPE Integrity MC990 X Server system to meet site requirements on a new system. You also can reinstall the software if there is a disaster or a system failure.

After the OS and Foundation Software are installed on the server, you can configure Foundation Software according to your site needs. For information about Foundation Software components and features, see the HPE Integrity MC990 X Server User Guide.

**NOTE:** HPE recommends that you install new Foundation Software packages as they become available.

HPE requires you to install the Foundation Software on each Integrity MC990 X system. You can install the Foundation Software on the MC990 X server chassis after you install the operating system software.
Integrity MC990 X system software installation

HPE installs operating system software, the Foundation Software, and any additional customer-purchased software after the Integrity MC990 X system hardware is installed at the customer site.

If your site practices require you to reinstall the software, or if a disaster occurs at your site, you can use the procedures in this guide to reinstall all the factory-installed software. The procedures in this guide assume the following:

- You are familiar with Linux operating systems, and are familiar with the operating system software update process. The installation instructions describe how to register the operating system installation with the operating system software provider to ensure automatic updates. This guide assumes that your site wants to use the automatic updates. As an alternative, you can use physical media to apply updates.
- You want to reinstall the factory-installed software on the MC990 X server chassis.
- Your Integrity MC990 X system is cabled correctly and attached to the network in accordance with your site practices.

There is a specific order in which you need to install software on an Integrity MC990 X system. This order is as follows:

1. Operating system software.
2. Foundation Software (SFS), which is required for RHEL and SLES installations.

More information

- Installing Oracle Linux software on an MC990 X server on page 33
- Installing VMware vSphere on an HPE MC990 X Server on page 35
- Installing SUSE Linux Enterprise Server on page 14
- Installing Red Hat Enterprise Linux or Oracle Linux on page 23

Gathering installation materials and information

Gathering needed information in advance for the MC990 X server operating system installation session will help you complete the installation more quickly.

Procedure

1. Verify your environment.
   Integrity MC990 X system installations require you to have physical access to the MC990 X server chassis and the RMC.
   Depending on your hardware, you might need additional equipment or specific network connections. Make sure that you have access to the RMC and the DVD drive that is included on the server.

2. Locate the software DVDs or CDs that are provided by HPE, or download and create DVDs or CDs.
   This guide assumes that you have DVDs of the operating system and CDs of the software.
   You can obtain the operating system software in one of the following ways:
   - In a media kit from HPE. HPE distributes DVD copies of the operating system releases.
   - As a software download. You can download the OS releases from the Red Hat, SUSE, or Oracle websites and write the software to a DVD.
You can obtain the Foundation Software from the HPE customer support center. To download the software, complete the following steps:

a. In a browser window, navigate to the following URL:

www.hpe.com/support/hpesc

b. Select the system (MC990 X) and the OS.

c. View or download the software release notes.

d. Download the software bundle(s) that you need. If you install the OS, also plan to install the Foundation Software. The HPE support center prompts you for your username and password.

e. Write the ISO file to a CD or DVD.

The instructions in this guide assume that you have hard media. Some procedures explain how to access the release software if you want to install from a network-resident ISO image, but the instructions are not comprehensive. If you downloaded the ISO images to a local network but do not want to copy them to hard media, plan to use your network tools to access the software when the procedures instruct you to insert a DVD or CD.

3. Plan the order in which to install the software.

Install the OS software first, then install the Foundation Software on the MC990 X server chassis.

4. Gather the information that the installer requires.

The installation requires you to provide information about passwords, your public (or house) network, and so on. You can complete the installation more quickly if you gather this information before you begin. Obtain the system configuration information that was used when the Integrity MC990 X system was originally configured. The following list shows the information you need to collect:

- MC990 X server FQDN ________________________________
- MC990 X server hostname ________________________________
- MC990 X server IP address ________________________________
- MC990 X server subnet mask ________________________________
- Site DNS server IP addresses ________________________________
- Site search domain ________________________________
- Password for the MC990 X server system administrator (root user) login ________________________________
- FQDN of your site network time protocol (NTP) server ________________________________
- IP address of your primary name server ________________________________
- IP address of your secondary name server ________________________________
- RMC FQDN ________________________________
- For RHEL installations, do the following:
- Verify your site Red Hat Networks (RHN) registration status and your Customer Center registration status.
- Obtain your RHN login.
- Obtain your RHN password.

- For SLES installations, do the following:
  - Determine the email address you want to use when you register with the SUSE Customer Center.
  - (Optional) Obtain the activation code for SLES components.
  - (Optional) Determine the system name or description.

5. Familiarize yourself with the hardware components in the rack.

Identify the base server chassis in the rack and the DVD drive on the chassis. Figure 1: MC990 X server chassis on page 8 shows the location of the DVD drive, along with other components and ports, on the MC990 X server chassis.

![Diagram of MC990 X server chassis]

- USB ports (4)
- ETH0
- DVD drive
- System drive assembly
- RMC port
- MGMT port
- Serial port
- VGA port
- Optional 1.8-inch SSD drive bays
- NUMAlink ports (28)

6. Proceed to one of the following:

- (Optional) To set an administrative password for the local console, proceed to (Optional) Setting or changing an administrative password on the system console on page 9.
HPE does not require that you set an administrative password, but you can do so if you are logged into a direct-attached, local console. After you set this password, you can proceed with the software installation.

- To install the operating system and Foundation Software on an MC990 X server, proceed to Creating an installation environment on page 11/

(Optional) Setting or changing an administrative password on the system console

The procedure in this topic explains how to set, or change, an administrative password on the console attached to an Integrity MC990 X system. A password is not required.

To delete a console password, enter the following command, which clears the EFI variables:

```
RMC> power -c reset
```

If you delete the password with the `power -c reset` command, you need to go back through the setup screens to set it again.

To set or change an administrative password on the console:

**Procedure**

1. Log in to the Integrity MC990 X system as the root user.
2. (Conditional) Shut down the system. Complete this step if the system is running at this time. Enter the following command:
   ```
   # shutdown now
   ```
3. Log in to the RMC as the root user.
4. From the RMC, enter the following command to reset the power:
   ```
   RMC> power -s reset
   ```
5. Wait for the reset to complete and enter the following command to start a console session on the base I/O BMC:
   ```
   RMC> uvcon
   ```
6. On the Integrity MC990 X system console BIOS main menu, press F2.
   This action selects to enter setup and select boot options.
   **Figure 2: Integrity MC990 X system boot options screen** on page 10 shows the Integrity MC990 X system BIOS menu options.
7. On the Boot Manager screen, select **Device Manager** and press **Enter**.

**Figure 3: Integrity MC990 X system boot manager screen** on page 10 shows the boot manager screen.

8. On the Device Manager screen, select **Security** and press **Enter**.

The following list shows how to navigate the device manager:
• **F1** scrolls the help.

• **Shift+6** (`,`), **v**, or arrow keys highlight a selection.

• **F9** resets system defaults.

• **Enter** selects.

• **F10** saves.

• **Esc** exits without saving.

• Plus (+) and minus (−) keys change setting values.

• To exit the console, press **CTRL+J**, and then press **q**. This sequence drops you to the RMC console.

9. On the Security screen, select the **Admin Password** option, and press **Enter**.

10. In the **Please type in your new password** field, type the new administrative password, and press **Enter**.

    The minimum password length is 6 characters and the maximum password length is 30 characters. The password is case sensitive.

    The next time you boot the system, the system will prompt you to type the new password at the end of the boot sequence. The system issues this prompt before the **Shell>** prompt appears.

11. Press **F10** to save the change.

12. Press **Esc** twice to return to the boot manager.

13. To return to the RMC console, press **CTRL+J**, and then press **q**.

14. Proceed to **Creating an installation environment** on page 11.

### Creating an installation environment

You can install the MC990 X server software by making a direct connection to the MC990 X server.

**Procedure**

1. Log in to the RMC as the root user.

2. From the RMC, power-on the server.

3. Put the DVD in to the DVD drive in the MC990 X server chassis that includes the BaseIO riser.

    If you are installing the software on a partitioned Integrity MC990 X system, put the DVD into the drive in the MC990 X server chassis that includes the BaseIO riser for your partition.

    For information about partitioning, see the *HPE Foundation Software User Guide*.

4. From the RMC, enter the following command to perform a quick reset:

    ```bash
    # power -s reset
    ```

    The quick reset in this step sets the system to its smallest possible configuration. A later procedure includes a step to reset the whole system.

5. Wait for the system to reset.

    The reset is complete when the **RMC>** prompt appears.

6. At the **RMC>** prompt, enter the following command to open a console to the shell:
7. At the MC990 X server chassis BIOS menu, press F2 to enter setup and select boot options.

8. Use the arrow keys to highlight Boot Manager Menu, and press Enter.

9. Use the arrow keys to highlight UEFI JMicron USB to ATA/ATAPI bridge ..., and press Enter.

10. If preparing a RHEL or SLES system, select an installation activity.
   - For a RHEL installation, use the arrow keys to navigate to Install Red Hat Enterprise Linux X, and press Enter.
   - For a SLES installation, on the SUSE Linux Enterprise Server X screen, press Enter to select Installation and start the SLES installation.

11. Install a supported operating system, such as RHEL, SLES, or VMware vSphere.

**Connecting to the server over the network (remote connection) using PXE**

You can install the operating system on the server within a preboot execution environment (PXE). You must be on a system that can connect to the server over the network.

**NOTE:** The operating system documentation for your local system includes information about PXE. To connect to the server, use your operating system documentation and the documentation in this topic. If you have trouble with this procedure, verify the boot order of the server.

The following procedure explains how to start PXE.

**Procedure**

1. To configure a PXE server, use the documentation from your operating system vendor.

   Make sure that the PXE server can serve operating system images to other systems.

   Refer to the operating system and the HPE Foundation Software installation procedures in this guide for any specific boot parameters to be added to the PXE server setup.

   Examples: When creating a boot image from the distribution media, perform the following modification to the PXE server configuration file:

   - RHEL 7: Edit the installer kernel boot line to remove quiet and add erst_disable edac_report=off console=ttyS0.115200 earlyprintk=ttyS0.115200 bau=0 mce=2 nmi_watchdog=0 pci=nobar.
   - SLES 12, SLES 15: Edit the installer kernel boot line to add edac_report=off console=ttyS0.115200 earlyprintk=ttyS0.115200 bau=0 mce=2 nmi_watchdog=0 pci=nobar.
   - Oracle 7: Edit the installer kernel boot line to remove quiet and add erst_disable edac_report=off console=ttyS0.115200 earlyprintk=ttyS0.115200 bau=0 mce=2 nmi_watchdog=0 pci=nobar.

2. Use an ssh client, such as PuTTY, to log into the RMC as the administrator user.

   For example:
localhost% ssh administrator@flex-rmc

For the password, enter the current RMC password for the administrator user, and press Enter.

If you configured a site-specific RMC password during the installation and configuration process, use your site-specific password.

If you did not specify a site-specific RMC password, create a site-specific password at this time. The factory-default RMC password appears on the password sticker. The password sticker is a bar coded sticker that appears on your system.

For information about how to change the RMC password and about the placement of the password sticker, see your system User Guide.

3. From the RMC prompt, use the power on command to power on the system partition.

For example, to power on partition 0:

RMC cli> power on npar pnum=0

4. Wait for the partition to power on.

The power ON is complete when the RMC prompt reappears.

5. At the RMC prompt, enter the following command to open a console to the shell. For example to open the console of partition 0:

RMC cli> connect npar pnum=0

6. When the following BIOS boot menu appears, press F2:

Press [Enter] to directly boot.
Press [F2] to enter setup and select boot options.
Copyright (c) 2006-2016, Intel Corporation

7. On the boot manager screen, use the arrow keys to highlight > Boot Manager Menu, and press Enter.

8. On the Boot Manager Menu, use the arrow keys to highlight one of the LAN devices, and press Enter.

For example, highlight UEFI BASEIO IPv4 Network @ r001i01 - LAN 0.

9. Install an operating system and the HPE Foundation Software.
Installing SUSE Linux Enterprise Server

This procedure explains how to install and configure the following software:

- The SLES operating system.
- Foundation Software for HPE MC990 X and SGI UV systems (SFS).

See the following table for the minimum SFS version required for each OS. Hewlett Packard Enterprise recommends using the latest released SFS version.

<table>
<thead>
<tr>
<th>Foundation Software for HPE MC990 X and SGI UV systems (SFS)</th>
<th>Operating system</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFS 2.16</td>
<td>SLES 11 SP3, SP4</td>
</tr>
<tr>
<td></td>
<td>SLES 12 SP1, SP2</td>
</tr>
<tr>
<td>SFS 2.18</td>
<td>SLES 11 SP4</td>
</tr>
<tr>
<td></td>
<td>SLES 12 SP1, SP2, SP3</td>
</tr>
<tr>
<td>SFS 2.19</td>
<td>SLES 11 SP4</td>
</tr>
<tr>
<td></td>
<td>SLES 12 SP1, SP2, SP3</td>
</tr>
<tr>
<td>SFS 2.20</td>
<td>SLES 12 SP2, SP3, SP4</td>
</tr>
<tr>
<td></td>
<td>SLES 15</td>
</tr>
<tr>
<td>SFS 2.21</td>
<td>SLES 12 SP1, SP2, SP3, SP4</td>
</tr>
<tr>
<td></td>
<td>SLES 15</td>
</tr>
<tr>
<td>SFS 2.22</td>
<td>SLES 12 SP2, SP3, SP4</td>
</tr>
<tr>
<td></td>
<td>SLES 15 SP1</td>
</tr>
</tbody>
</table>

Procedure

1. **Initiate SLES installation.**
2. **Use SLES to partition the disk.**
3. **Configure SLES network and miscellaneous settings.**
4. **Install Foundation Software (SFS).**

**Initiating SLES installation**

**Prerequisites**

Gather installation materials and information you need for the operating system installation.
Procedure

1. On the SUSE Linux Enterprise Server x screen, which is the boot loader screen, select Installation.
   
   a. On the grub menu, select Advanced options for SLES x.
      
      Press E (for edit).
   
   b. Edit the boot line, adding: edac_report=off console=ttyS0,115200 earlyprintk=ttyS0,115200 bau=0 mce=2 nmi_watchdog=0 pci=nobar
   
   c. Press Ctrl-X to start the boot.

2. Wait a few moments while the software loads.

3. On the Language, Keyboard and License Agreement page, complete the following steps:
   
   a. Use the pull-down menu to select your language.
   
   b. Use the pull-down menu to select your keyboard layout.
   
   c. Check I Agree to the License Terms.
   
   d. Click Next.

4. On the System Probing ... screen, monitor the progress.

5. On the Registration screen, complete the following steps:
   
   a. Provide your site credentials.
   
   b. Click Next.


7. On the System Role screen, select Default System, and click Next.


More information

Installing SUSE Linux Enterprise Server on page 14
Using SLES to partition the disk on page 15

Using SLES to partition the disk

This topic explains how to partition the disk and how to monitor a reboot.

Configure the disks according to the following table.

Table 1: Disk partitions

<table>
<thead>
<tr>
<th>Size</th>
<th>Mount Point</th>
<th>Filesystem</th>
</tr>
</thead>
<tbody>
<tr>
<td>512 MB</td>
<td>/boot/efi</td>
<td>FAT16</td>
</tr>
<tr>
<td>250 GB (256,000 MB)</td>
<td>/</td>
<td>XFS</td>
</tr>
</tbody>
</table>

Table Continued
Procedure

1. On the **Expert Partitioner** screen, complete the following steps to clean the disk:
   a. Expand **Hard Disks**.
   b. Select the disk you want to use.
      For example, select `sda`.
   c. On the **Expert ...** drop-down in the lower right part of the screen, select **Create New Partition Table**.
   d. On the YaST2 pop-up with the message **Really create a new partition table ...**, click **Yes**.
   e. Expand **Hard Disks**.
   f. Select the hard disks you want to use.
   g. Click **Add**.

2. Complete the following steps on the **Add Partition on /dev/disk** screen to configure the boot partition:
   a. Under **New Partition Size**, click **Custom Size**.
   b. Enter 512 MB in the **Size** field.
   c. Click **Next**.
   d. Under the **Role** list, complete the following steps:
      1. Select **Operating System**.
      2. Click **Next**.
   e. Under **Formatting Options**, select **Format partition**.
   f. Under **File system**, use the pull-down menu to select **FAT**.
   g. Under **Mounting Options**, select **Mount Partition**.
   h. Under **Mount point**, use the pull-down menu to select `/boot/efi`.
   i. Select **Finish**.

3. On the **Expert Partitioner** screen, click **Add**.

4. Complete the following steps on the **Add Partition on /dev/disk** screen to configure the root partition:
   a. Under **New Partition Size**, click **Custom Size**.
   b. Enter 250 GB in the **Size** field.
   c. Click **Next**.
   d. Under the **Role** list, complete the following steps:
• Select **Operating System**.
• Click **Next**.

e. Under **Formatting Options**, select **Format partition**.

f. Under **File system**, use the pull-down menu to select **XFS**.

g. Under **Mounting Options**, select **Mount Partition**.

h. Under **Mount point**, use the pull-down menu to select **/**.

i. Select **Finish**.

5. On the **Expert Partitioner** screen, click **Add**.

6. Complete the following steps on the **Add Partition on /dev/disk** screen to configure the swap partition:

   a. Under **New Partition Size**, click **Custom Size**.

   b. Specify **8 GB** in the **Size** field.

   c. Click **Next**.

   d. Under the **Role** list, complete the following steps:

      • Select **Swap**.

      • Click **Next**.

   e. Under **Formatting Options**, select **Format partition**.

   f. Under **File system**, use the pull-down menu to select **Swap**.

   g. Under **Mounting Options**, select **Mount Partition**.

   h. Under **Mount point**, use the pull-down menu to select **swap**.

   i. Select **Finish**.

7. On the **Expert Partitioner** screen, click **Add**.

8. Complete the following steps on the **Add Partition on /dev/disk** screen to configure the data partition:

   a. Under **New Partition Size**, click **Maximum Size**.

   b. Click **Next**.

   c. Under the **Role** list, complete the following steps:

      i. Select **Data and ISV Applications**.

      ii. Click **Next**.

   d. Under **Formatting Options**, select **Format partition**.

   e. Under **File system**, use the pull-down menu to select **XFS**.

   f. Under **Mounting Options**, select **Mount Partition**.
g. Under **Mount point**, enter `/data1`.

h. Select **Finish**.

9. On the **Expert Partitioner** screen, in the **Partitions** tab, examine the disk partitions.
   If the partitions match the disk partitions in **Disk partitions**, click **Accept**.
   If the partitions are incorrect, correct the partition specifications.

10. On the **Suggested Partitioning** screen, click **Next**.

11. On the **Clock and Time Zone** screen, complete the following steps:
   a. Select your region.
   b. Select your time zone.
   c. Check the box next to **Hardware Clock Set To UTC**.
   d. Click **Next**.

12. On the **Local Users** screen, click **Create New User**.
    Complete the following steps:
    a. Complete the following fields:
       - **User's Full Name**
       - **Username**
       - **Password**
       - **Confirm Password**
    b. Click **Next**.

13. On the **Password for the System Administrator “root”** screen, complete the following steps:
    a. In the **Password for root User** field, enter the root user password.
    b. In the **Confirm password** field, re-enter the root user password.
    c. Enter a few characters in the **Test Keyboard Layout** field.
       For example, if you specified a language that includes non-English characters and you include these characters in passwords, enter these characters into this field. This field is a plain text field. You assure yourself that the operating system can recognize these characters when you enter them.
    d. Click **Next**.

14. On the **Installation Settings** screen, configure additional features as needed and click **Install**.

15. On the **Confirm Installation** pop-up, click **Install**.

16. Monitor the installation and, if you are using hard media, be prepared to remove the installation software media before the boot.
    The installation itself can take several minutes. At the end of the installation, the system boots. The installation software notifies you of this boot. If you can, remove the installation DVD before the system boots.
If you fail to remove the installation DVD before the final boot, the machine boots from the DVD. In this case, complete the following steps:

a. Remove the DVD after the boot.
b. Press **CTRL-ALT-DEL** to boot the machine again.
c. Allow the machine to boot from the hard disk to finish the installation.

If you are installing over the network, the JViewer software manages the disk.

More information

[Installing SUSE Linux Enterprise Server](#) on page 14
[Configuring SLES network and miscellaneous settings](#) on page 19

**Configuring SLES network and miscellaneous settings**

**Procedure**

1. Log into the server as the root user.
2. Click **Applications** > **System Tools** > **YaST**.
3. On the **Administrator Settings** screen, click **Network Settings**.
4. On the **YaST2 -- Network Settings** screen, highlight the network card you want to configure, and click **Edit**.
5. On the **Network Card Setup** screen, specify dynamic or static addressing, as follows:
   - **To specify dynamic addressing:**
     1. Select the type of dynamic addressing that you want.
     2. Click **Next** to accept the default of DHCP.
   - **To specify static addressing:**
     1. Verify that *eth0* appears in the **Configuration Name** field, and click **Statically assigned IP Address**.
     2. Configure the first NIC (*eth0*) for your house (public) network.
        - On the **Address** tab, specify the following:
          - The **IP Address**
          - The **Subnet Mask**
          - The **Hostname**
     3. Click **Next**.
6. On the **Network Settings** screen, click the **Hostname/DNS** tab and complete the following steps:
   a. Enter the hostname.
   b. Enter the domain name.
   c. Verify that **Change Hostname via DHCP** is set correctly.
To assign a static IP address, clear the check box to the left of the **Change Hostname via DHCP** label. A later step saves the hostname to the `/etc/hosts` file. Consult your network administrator if you have questions regarding the use of DHCP.

**NOTE:** This procedure explains how to configure a static address on a network card. If you want a different network configuration, for example if you want to configure DHCP, ensure that the check box in this step is checked before you click **Next**. You can use this procedure as a guide and consult the SLES documentation for more specific steps.

d. The IP address for **Name Server 1**.
e. (Optional) The IP address for **Name Server 2**.
f. (Optional) The IP address for **Name Server 3**.
g. (Optional) In the **Domain Search** field, add additional domains.
h. Click the **Routing** tab.
i. On the **Routing** tab, enter the **Default Gateway**, and click **OK**.

**More information**

- Installing Foundation Software (SFS) on SLES platforms on page 20
- Installing SUSE Linux Enterprise Server on page 14

## Installing Foundation Software (SFS) on SLES platforms

**Procedure**

1. Insert the **HPE Foundation Software** media into the DVD drive or make a network connection to the repository.
2. Log into the server as the root user.
3. To start the YaST interface, click **Applications > System Tools > YaST**.
4. Under **Software**, click **Software Repositories** to start the SLES repository manager.
5. On the **Configured Software Repositories** screen, click **Add**.
6. On the **Add On Product** screen, select **DVD**, and click **Next**.
7. On the **YaST** pop-up, complete the following steps:
   a. Select the correct DVD.
   b. Click **Continue**.
8. On the **Import Untrusted GnuPG Key**, follow this procedure to import a trusted key.

**NOTE:** Perform this step if you are going through this process for the first time and you must confirm the security of the Hewlett Packard Enterprise digital key.

a. Download the keys.
   Copy the compressed tar file (**HPE-GPG-Public-Keys.tar.gz**) from this link to your local directory and extract the public keys.
b. Import the keys for GPG.
For each key that you have unzipped, install the public key using the `gpg --import` command.

```
# gpg --import /path_to_the_key/file_name_of_the_key
```
For example: `gpg --import /path_to_the_key/B1275EA3.pub`

c. Verify using GPG.
Use the `gpg --verify` command to validate and verify the digital signature of the signed file. The output from the command indicates the validity of the signature. Specify the `.sig` (detached signature) file and the corresponding input file in the command.

```
# gpg --verify filename.sig filename
```

If the level of trust on the key has not been set, you will see a trust level warning similar to the following:

```
gpg: WARNING: This key is not certified with a trusted signature!
gpg: There is no indication that the signature belongs to the owner.
```

Because you have downloaded the key from an SSL secured site by Hewlett Packard Enterprise Company, you can ultimately trust that this public key is indeed from Hewlett Packard Enterprise Company. Therefore edit the key to set the trust level of the key for proper verification.

d. Find the "key_name" of the key.
Type the following command and select the key that you must trust:

```
# gpg --list-keys
```

Example of a "key_name": "Hewlett Packard Enterprise Company RSA 2048 1"

e. Edit the key.

```
# gpg --edit-key "key_name"
```

Type the command "trust" and select "5" for trusting the key ultimately.

f. Confirm and enter `quit` to exit.

In the future, you will not see the warning about an untrusted identity when verifying the signature. Example verification:

```
# gpg --verify test.bin.sig test.bin
```
```
gpg: Signature made Thu 03 Jan 2013 04:48:47 PM UTC using RSA key ID 5CE2D476
```
```
gpg: Good signature from "Hewlett Packard Enterprise Company RSA 2048 1"
```

9. On the **Configured Software Repositories** screen, click **OK**.

10. On the **YaST Control Center** screen, click **Software Management**.

11. Select **View > Patterns**.

12. Scroll down to **HPE Foundation**.

13. Check the box to the left of **HPE Foundation Libraries, Software, and Drivers**, and click **Accept**.

14. On the **Changed Packages** pop-up, click **Continue**.

15. Insert the media into the DVD drive as directed by the prompts on the **Perform Installation** screen.
If necessary, click **Eject** on the YaST2 pop-up to open the DVD drive. In the **YaST** pop-up, you might need to click **Retry** more than once to read a new media.

16. On the **Installation Report** screen, click **Finish**.

17. Close the YaST session.

18. Open a terminal window on the booted system.

19. Log into the server as the root user.

20. In the terminal window, enter the following command to reboot the system.

```
# reboot
```
Installing Red Hat Enterprise Linux or Oracle Linux

This procedure explains how to install and configure the following software:

- The RHEL or Oracle Linux operating system.
- Foundation Software for HPE MC990 X and SGI UV systems (SFS).

See the following table for the minimum Foundation Software for HPE MC990 X and SGI UV systems (SFS) version required for each OS. Hewlett Packard Enterprise recommends using the latest released SFS version.

<table>
<thead>
<tr>
<th>Foundation Software for HPE MC990 X and SGI UV systems (SFS)</th>
<th>Operating system</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFS 2.16</td>
<td>RHEL 6.8, 6.9</td>
</tr>
<tr>
<td></td>
<td>RHEL 7.2, 7.3</td>
</tr>
<tr>
<td>SFS 2.18</td>
<td>RHEL 6.8, 6.9, 6.10</td>
</tr>
<tr>
<td></td>
<td>RHEL 7.2, 7.3, 7.4</td>
</tr>
<tr>
<td>SFS 2.19</td>
<td>RHEL 6.8, 6.9, 6.10</td>
</tr>
<tr>
<td></td>
<td>RHEL 7.2, 7.3, 7.4, 7.5</td>
</tr>
<tr>
<td>SFS 2.20</td>
<td>RHEL 7.2, 7.3, 7.4, 7.5, 7.6</td>
</tr>
<tr>
<td>SFS 2.21</td>
<td>RHEL 7.2, 7.3, 7.4, 7.5, 7.6</td>
</tr>
<tr>
<td>SFS 2.22</td>
<td>RHEL 7.5, 7.6, 7.7</td>
</tr>
<tr>
<td></td>
<td>RHEL 8.0</td>
</tr>
</tbody>
</table>

**Procedure**

1. **Initiate RHEL installation and partition the disk.**
2. **Configure RHEL networking and reboot.**
3. **Complete RHEL installation.**
4. **Install the Foundation Software (SFS).**

**Initiating RHEL installation and partitioning the disk**

**Prerequisites**

Gather installation materials and information you need for the operating system installation.

**Procedure**

1. On the boot loader menu, complete the following steps:
a. Use the arrow keys to select **Install Red Hat Enterprise Linux x.x**.

b. Press **E** (for edit).

   Edit the installer kernel boot line to remove `quiet` and add `erst_disable edac_report=off console=ttyS0.115200 earlyprintk-ttyS0.115200 bau=0 mce=2 nmi_watchdog=0 pci=nobar`

c. Press **Ctrl-X** to start the boot.

2. Wait a few moments while the software loads.

3. On the **WELCOME ...** screen, which asks **What language would you like to use during the installation process?**, complete the following steps:
   
a. Select your language.

   b. Click **Continue**.

4. On the **INSTALLATION SUMMARY** page, click **DATE & TIME**.

5. On the **DATE & TIME** page, complete the following steps:
   
a. Select your time zone.

   b. Select the date.

   c. Click **Done**.

6. On the **INSTALLATION SUMMARY** page, click **KEYBOARD**.

7. On the **KEYBOARD LAYOUT** page, complete the following steps:
   
a. Select your keyboard layout.

   b. Click **Done**.

8. On the **INSTALLATION SUMMARY** page, click **SOFTWARE SELECTION**.

9. On the **SOFTWARE SELECTION** page, complete the following steps:
   
a. Select **Server with GUI**.

   b. Click **Done**.

10. On the **INSTALLATION SUMMARY** page, complete the following steps:
    
a. Click **INSTALLATION DESTINATION**.

    b. Under **Local Standard Disks**, click the disk onto which you want to install the operating system.

    c. Under **Other Storage Options**, click **I will configure partitioning**.

    d. Click **Done**.

11. On the **MANUAL PARTITIONING** page, clean the disk.
The screen left pane lists the operating system installations that currently reside on the disk. Your goal is to remove all operating system installations, data, and partitions that reside on the disk. You can remove one operating system at a time.

To remove one operating system, complete the following steps:

a. Select the operating system name.

b. Click the minus sign (−) at the bottom of the left pane to delete the operating system.

c. On the Are you sure ... popup, complete the following steps:

   I. Select Delete all other ....

   II. Click Delete it.

d. Repeat the preceding steps, as needed, until all operating systems are removed.

12. In the left pane, from the New mount points will use the following partition scheme drop-down list, select Standard Partition.

13. Create mount points.

   Configure the disks according to the following table.

<table>
<thead>
<tr>
<th>Size</th>
<th>Mount point</th>
<th>Filesystem</th>
</tr>
</thead>
<tbody>
<tr>
<td>512 MB</td>
<td>/boot/efi</td>
<td>FAT16</td>
</tr>
<tr>
<td>250 GB (256,000 MB)</td>
<td>/</td>
<td>XFS</td>
</tr>
<tr>
<td>8 GB (8,192 MB)</td>
<td>swap</td>
<td>swap</td>
</tr>
<tr>
<td>rest of disk</td>
<td>/data1</td>
<td>XFS</td>
</tr>
</tbody>
</table>

   To create disk mount points, complete the following steps:

   a. In the left pane, click the plus sign (+) to add a mount point.

   b. On the ADD A NEW MOUNT POINT popup, complete the following steps:

      I. On the Mount Point drop-down menu, select /boot/efi.

      II. On the Desired Capacity field, enter 512mb.

      III. Click Add mount point.

   c. In the left pane, click the plus sign (+) to add a mount point.

   d. On the ADD A NEW MOUNT POINT popup, complete the following steps:
I. On the **Mount Point** drop-down menu, select `/`

II. On the **Desired Capacity** field, enter **250gb**.

III. Click **Add mount point**.

e. In the left pane, click the plus sign (+) to add a mount point.

f. On the **ADD A NEW MOUNT POINT** popup, complete the following steps:

   I. On the **Mount Point** drop-down menu, select **swap**.

   II. On the **Desired Capacity** field, enter **8gb**.

   III. Click **Add mount point**.

g. In the left pane, click the plus sign (+) to add a mount point.

h. On the **ADD A NEW MOUNT POINT** popup, complete the following steps:

   I. In the **Mount Point** field, enter `/data1`.

   II. Leave the **Desired Capacity** field blank.

   III. Click **Add mount point**.

i. Verify that the **Desired Capacity** field shows the rest of the disk.

j. Click **Done**.

14. On the **SUMMARY OF CHANGES** popup, click **Accept Changes**.

15. On the **INSTALLATION SUMMARY** page, click **KDUMP**.

16. On the **KDUMP** page, complete the following steps:

   a. Next to **Kdump Memory Reservation**, click **Manual**.

   b. In the **Memory to be Reserved (MB)** field, specify **450 MB**.

   c. Click **Done**.

More information

  Configuring RHEL network and rebooting on page 26
  Installing Red Hat Enterprise Linux or Oracle Linux on page 23

**Configuring RHEL network and rebooting**

**Procedure**

1. On the **INSTALLATION SUMMARY** page, click **NETWORK & HOST NAME**.

2. On the **NETWORK & HOST NAME** page, complete the following steps:

   a. Select the Ethernet device that you want to configure.

   b. In the right pane, in the upper-right corner of the screen, find the **ON/OFF** switch, and click the blank box to set the **ON/OFF** switch to **ON**.
c. Click **Configure**.

d. On the **Editing device_name** popup, select **IPv4 Settings**.

e. Complete this step according to the following table:

<table>
<thead>
<tr>
<th>To specify dynamic addressing:</th>
<th>To specify static addressing:</th>
</tr>
</thead>
<tbody>
<tr>
<td>1. In the <strong>Method:</strong> drop-down menu, select <strong>Automatic (DHCP).</strong></td>
<td>1. In the <strong>Method:</strong> drop-down menu, select <strong>Manual.</strong></td>
</tr>
<tr>
<td>2. On the <strong>Editing</strong> pop-up, click <strong>Save.</strong></td>
<td>2. In the <strong>Addresses</strong> pane, click <strong>Add,</strong> and complete the following steps:</td>
</tr>
<tr>
<td></td>
<td>• Enter the IP address.</td>
</tr>
<tr>
<td></td>
<td>• Enter the netmask.</td>
</tr>
<tr>
<td></td>
<td>• Enter the IP address of the default gateway.</td>
</tr>
<tr>
<td>3. In the <strong>DNS servers:</strong> field, enter the IP address of one or more DNS servers. If you specify more than one, use a comma to separate each IP address.</td>
<td>4. In the <strong>Search domains:</strong> field, enter one or more search domains. If you specify more than one, use a comma to separate each domain.</td>
</tr>
<tr>
<td>5. On the <strong>Editing</strong> pop-up, click <strong>Save.</strong></td>
<td></td>
</tr>
</tbody>
</table>

f. In the **Host name** field, enter the hostname of the system.

g. Click **Done.**

3. On the **INSTALLATION SUMMARY** page, click **Begin Installation.**

4. On the **CONFIGURATION** page, click **ROOT PASSWORD.**

5. On the **ROOT PASSWORD** page, complete the following steps:

   a. In the **Root Password** field, enter the password you want to use on this system.
   
   b. In the **Confirm** field, enter the password again.
   
   c. Click **Done.**

   If the password is too weak, either specify a stronger password or click **Done** twice.

6. On the **CONFIGURATION** page, complete the following steps:

   a. Wait for the installation to complete.
   
   b. Click **Reboot** when the installation completes.
   
   c. Wait for the reboot to finish.
The OS auto boots after being rebooted. Wait for the GRUB menu and complete the following step.

d. When the GRUB menu appears, press e to edit the top command line.

- (RHEL 7.3) Skip this step. You do not need to edit the boot parameters with the GRUB menu.
- (RHEL 7.5, RHEL 7.4, and Oracle Linux) The top line is highlighted to select the RHEL version. Do NOT select the rescue mode version.

7. To reset the boot parameters, complete the following steps:

- (RHEL 7.3) Skip this step. You do not need to edit the boot parameters with the GRUB menu.
- (RHEL 7.5) Complete these steps:
  a. On the boot loader menu, use the arrow keys to select Install Red Hat Enterprise Linux x.x.
  b. Press E (for edit).

    Edit the installer kernel boot line to remove quiet and add erst_disable edac_report=off
    console=ttyS0.115200 earlyprintk=ttyS0.115200 bau=0 mce=2
    nmi_watchdog=0 pci=nobar

c. To start the boot, press Ctrl-X.

- (RHEL 7.4 and Oracle Linux) Complete these steps:
  a. Enter the following string at the end of the linuxefi kernel command line:

    modprobe.blacklist=skx_edac

    Use a backslash (\) character if needed, to continue the line appropriately. The following figure shows the newly edited file and the use of the backslash.

    Press Ctrl-x to start, Ctrl-c for a command prompt or Escape to discard edits and return to the menu. Pressing Tab lists possible completions.

  b. Press CTRL-X to start the boot.

8. (Optional) On the CONFIGURATION page, click USER CREATION and follow the prompts.
Complete this optional step if you want to configure additional user accounts.

More information

Completing RHEL installation on page 29
Installing Red Hat Enterprise Linux or Oracle Linux on page 23

Completing RHEL installation

NOTE: If a read/write console connection from the RMC is active, Steps 1-5 may appear on the active console connection rather than on the local attached keyboard, monitor, and mouse.

Procedure

1. On the INITIAL SETUP page, click LICENSE INFORMATION.
2. On the LICENSE INFORMATION page, complete the following steps:
   a. Click I accept the license agreement.
   b. Click Done.
3. Perform one of the following:
   • (RHEL 7.5, RHEL 7.4, and Oracle Linux) On the INITIAL SETUP page, click Subscription Manager.
   • (RHEL 7.3) On the Subscription Management Registration page, click Forward.
4. On the Subscription Manager (RHEL 7.5, RHEL 7.4, and Oracle Linux) page or the second Subscription Management Registration (RHEL 7.3) page, complete the following steps:
   a. Complete the fields according to your site practices.
   b. Click Done.
5. Click FINISH CONFIGURATION.
6. On the Welcome page, complete the following steps:
   a. Select your language.
   b. Click Next.
7. On the Typing page, complete the following steps:
   a. Select the language you use.
   b. Click Next.
8. Select one of the following:
   • (RHEL 7.3) skip this step.
   • (RHEL 7.5, RHEL 7.4, and Oracle Linux) On the Privacy page, complete the following steps:
a. In the right pane, in the upper-right corner of the screen, find the **ON/OFF** switch. Click the blank box to set **Location Services** to **OFF**.

b. Click **Next**.

9. On the **Time Zone** page, complete the following steps:
   a. Type your location, click the magnifying glass search icon, and press **Enter**.
   b. Click **Next**.

10. On the **Connect Your Online Accounts** (RHEL 7.5, RHEL 7.4, and Oracle Linux) page or **Online Accounts** page (RHEL 7.3), click **Skip**.

11. On the **About You** page, complete the following steps to create the local user account:
   a. Complete all the fields on this page.
   b. Click **Next**.

12. On the **Set a Password** page, complete all fields and click **Next**.

13. On the **You’re ready to go** page, click **Start using Red Hat Enterprise Linux Server**.

**More information**

- Installing the Foundation Software (SFS) on RHEL and Oracle platforms on page 30
- Installing Red Hat Enterprise Linux or Oracle Linux on page 23

**Installing the Foundation Software (SFS) on RHEL and Oracle platforms**

**Procedure**

1. Log in to the MC990 X server as the root user.

2. On the login page, complete the following steps:
   a. Select **Not Listed?**.
   b. In the Username field, enter **root**.
   c. In the Password field, enter the root user’s password.
   d. Click **Log In**.
   e. (Conditional) Initialize the root user account.

      Complete these steps only if this is the first time you are logging in as the root user.

   l. On the **Welcome** page, complete the following steps:
i. Select your language.
ii. Click Next.

II. On the Input Sources page, complete the following steps:

i. Select the language you use.
ii. Click Next.


3. Access the installation software.
   Insert the HPE Foundation Software CD into the DVD drive.

4. Click Applications→System Tools→Terminal to open a terminal window.

5. Enter the following command to create an installation directory for the files from the CD.
   ```
   # mkdir -p /opt/hpe/Factory-Install/hpe-foundation-X.X/
   ```

6. Enter the following command to create a temporary mount directory.
   ```
   # mkdir /var/sfs.X
   ```

7. Enter the following command to mount the CD in read-only mode (-r), using a loop device:
   ```
   # mount -t iso9660 -ro loop /dev/cdrom /var/sfs.X
   ```

8. Enter the following command to copy the files from the temporary mount directory to the installation directory.
   ```
   # rsync -avHx /var/sfs.X/ /opt/hpe/Factory-Install/hpe-foundation-X.X/
   ```

9. Enter the following command to unmount the CD from the temporary directory.
   ```
   # umount /var/sfs.X
   ```

10. Run the create-yum-config-file.
    ```
        # /opt/hpe/Factory-Install/hpe-foundation-X.X/create-yum-config-file
    ```

11. Enter the following command to remove the temporary mount directory.
    ```
        # rmdir /var/sfs.X
    ```

12. Use a text editor to create the /etc/yum.repos.d/foundationX.X-local.repo file with the following contents.
    ```
    [foundationX.X-repo]
    name=Foundation Software X.X - $basearch
    baseurl=file:///opt/hpe/Factory-Install/hpe-foundation-X.X/RPMS
    enabled=1
    gpgcheck=1
    gpgkey=file:///opt/hpe/Factory-Install/hpe-foundation-X.X/RPM-GPG-KEY-sgi
    ```

13. Enter the following command to retrieve the list of software that you can install.
14. Enter the following command to install the Foundation Software group.

```
# yum grouplist | grep HPE
```

15. Enter `y` at the following prompt to confirm the download size.

```
Is this ok [y/N]
```

16. Enter `y` at the following prompt to accept the GPG license key.

```
Is this ok [y/N]
```

17. Open a terminal window on the booted system.

18. In the terminal window, enter the following command to reboot the system.

```
# reboot
```

19. After the system reaches the EFI shell, in the RMC command window, enter the following command to reset the full system.

```
# power reset
```
The process for installing Oracle Linux is nearly identical to the process for installing RHEL, with some minor changes.

See the following table for the minimum Foundation Software for HPE MC990 X and SGI UV systems (SFS) version required for each OS. Hewlett Packard Enterprise recommends using the latest released SFS version.

<table>
<thead>
<tr>
<th>Foundation Software for HPE MC990 X and SGI UV systems (SFS)</th>
<th>Operating system</th>
</tr>
</thead>
<tbody>
<tr>
<td>SFS 2.16</td>
<td>Oracle Linux 7.3</td>
</tr>
<tr>
<td>SFS 2.18</td>
<td>Oracle Linux 7.3</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.4</td>
</tr>
<tr>
<td>SFS 2.19</td>
<td>Oracle Linux 7.3</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.4</td>
</tr>
<tr>
<td>SFS 2.20</td>
<td>Oracle Linux 7.3</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.4</td>
</tr>
<tr>
<td>SFS 2.21</td>
<td>Oracle Linux 7.3</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.4</td>
</tr>
<tr>
<td>SFS 2.22</td>
<td>Oracle Linux 7.5</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.6</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 7.7</td>
</tr>
<tr>
<td></td>
<td>Oracle Linux 8.0</td>
</tr>
</tbody>
</table>

Oracle Linux comes with two kernels:

- RHEL-based kernel
- Oracle Unbreakable Enterprise Kernel (UEK) kernel

**Procedure**

1. After installing Oracle Linux, reboot.
2. From the boot menu, choose the RHEL-based kernel
3. Type `e` to edit the boot line
4. Add the boot option `nobau` to the boot line
5. Boot the system
6. When the system comes up, install the System Foundation Software as described in the RHEL instructions.
7. Once the Foundation Software (SFS) is installed, run the following commands.
modprobe hwperf
# /usr/sbin/x86config

8. If the system will be running with the Oracle Unbreakable Enterprise Kernel (UEK), you must also install the `hwperf` kernel module package. Use the package built for use with the UEK as follows (UEK version of 3.8.13-105 or later is required).

```bash
# yum -c /tmp/yum-sgi.conf install kmod-hwperf-uek
# yum update kernel-uek
```

9. After installing all packages, reboot the system to complete the installation, and boot with optimized kernel command-line parameters.
Installing VMware vSphere on an HPE MC990 X Server

**Introduction**

VMware vSphere is a virtualization platform for building cloud infrastructures using existing IT assets and resources. This information explains how to install VMware vSphere Software on an MC990 X server chassis.

**Supported VMware vSphere distributions**

HPE Integrity MC990 X supports the following VMware vSphere distributions. The VMware base ISO image includes the base ESXi hypervisor and initial set of drivers.

- **VMware vSphere 6.5**
  
  The VMware 6.5 base ISO image is available for download at the [VMware site](https://my.vmware.com/web/vmware/info/slug/datacenter_cloud_infrastructure/vmware_vsphere/6_5).

- **VMware vSphere 6.7 U3**
  
  The VMware 6.7 U3 base ISO image is available for download at the [VMware site](https://my.vmware.com/group/vmware/details?downloadGroup=ESXI67U1&productid=742).
  
  Select version 6.7.0U3 from the pull-down menu and then download the corresponding VMware 6.7 U3 Base ISO image.

  The following I/O adapters were tested on MC990 X Server configuration VMware VSphere 6.7 U3.

  - H7B72A -- HPE MC990 10GbE Fiber 2-port Adapter
  - H7B75A -- HPE MC990 1000BASE-T 4-port 5719 Adapter
  - H7B97A -- HPE MC990 SN1100E 16Gb 2-port Fibre Channel Host Bus Adapter

**NOTE:** For complete HPE Integrity MC990 X ordering and configuration details, including supported OSs and the I/O support, see the HPE Integrity MC990 X Server QuickSpecs at [https://h20195.www2.hpe.com/v2/getpdf.aspx/c04912781.pdf](https://h20195.www2.hpe.com/v2/getpdf.aspx/c04912781.pdf).

**Installing the VMware vSphere image**

**Prerequisites**

- A dedicated LUN is required to install and boot the VMware vSphere. The size of the LUN should be greater than 10 GB.
- To mount and install the ESXi OS on an MC990 X server, you must use JViewer.
- You must have the fully qualified domain name (FQDN) of the MC990 X server on which you want to install the vSphere image.

**Procedure**

1. In JViewer, attach the VMware vSphere installer ISO through Media > Virtual Media > ISO Image.
2. Power on or reset the server partition.

3. Following the POST, press **F2** to enter setup and select the boot options.

4. Select the Boot Manager, and boot from the ISO image.

5. Press **Shift+O** within 5 seconds after the VMware hypervisor window appears.

6. Start the installation by entering `runweasel` and the appropriate boot parameters.

   • To install VMware vSphere 6.5, enter `runweasel tty2Port=com1` at the prompt and press **Enter** to start the installation.

   • To install VMware vSphere 6.7 U3, enter `runweasel timerForceTSC=TRUE tty2Port=com1` at the prompt and press **Enter** to start the installation.

**NOTE:**

Provide this set of boot parameters on every reboot of the server.
JViewer freezes and does not take any further input.

7. Using the FQDN of the MC990 X server on which you are installing vSphere, open the RMC console. Use the secure shell (ssh) command to log into the RMC.

For more information about logging into the RMC, see "Connecting to the RMC" in HPE Integrity MC990 X Server RMC Software User Guide.

8. Obtain the partition number by entering the `config -v` command on the RMC console.

9. On the RMC console, enter the `uvcon PARTITION-NUMBER` command, using the partition number obtained in the previous step.

10. After the server boots the VMware vSphere Installer, navigate the installation process.

11. On the Select a Disk to Install or Upgrade menu, select the intended LUN on which you want to install the VMware vSphere software, and then press Enter.
12. Continue to navigate the rest of the installation steps.

13. When the installation is complete, press **Enter** to reboot the host.

### Adding the boot entry

You can add the boot entry at the boot maintenance manager level and boot the VMware vSphere from the corresponding boot entry added.

**Procedure**

1. Following POST, select the EFI shell. Enter the command `map fs*` and note the LUN device name where you installed VMware vSphere (for example, FS0).
2. Check the LUN device name by listing the contents (for example, `dir fs0:EFI\BOOT\BOOTx64.efi`).
3. Exit the EFI shell by entering the `exit` command.
4. Enter the System Utilities, and navigate to **Boot Maintenance Manager** > **Boot Options Menu**. Select **Add Boot Option**.
5. Select the boot entry for VMware vSphere that matches the entry noted in steps 1 and 2), and then press Enter.
6. Complete adding the VMware vSphere entry to the boot options. Select <EFI> and press Enter.

7. Select the <BOOT> directory, not the <VMware> directory. Press Enter.
8. Select `BOOTx64.EFI` and press **Enter**.

9. Enter **ESXi X.X** in the **Input the description** field, and then press **Enter**. Specify the VMware vSphere version (X.X) being installed.
10. Navigate to **Boot Options Menu > Change Boot Order**. Set the boot order so that VMware vSphere ESXi (VMware vSphere) is the first option or as the next option. To commit the changes, press **Enter**.

11. Reset the server. During the next boot, VMware vSphere boots from the LUN.

12. After VMware vSphere is successfully booted, press **F2** to enable ssh, and so on, through Direct Console User Interface (DCUI).
Additional software features for the Integrity MC990 X system

Additional software features are used to remote manage, configure security, debug and create crash dumps for the Integrity MC990 X system.

**Remote management through the ipmitool command**

From a remote console, you can use `ipmitool` commands to perform typical system operations.

For the `ipmitool` command to work, the remote console must be on the same local network as the Integrity MC990 X system. The following shows the `ipmitool` command format:

```
ipmitool -I lanplus -H <hostname> -U ADMIN -P <password> <command>
```

The arguments to the command parameters are as follows:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>&lt;hostname&gt;</code></td>
<td>The hostname of the Integrity MC990 X system on your network.</td>
</tr>
<tr>
<td><code>&lt;password&gt;</code></td>
<td>The system administrative password. The factory-shipped, default password is <code>ADMIN</code>.</td>
</tr>
<tr>
<td><code>&lt;command&gt;</code></td>
<td>One of the <code>ipmitool</code> commands.</td>
</tr>
<tr>
<td></td>
<td>There many IPMI commands. The commands that HPE supports for Integrity MC990 X system remote management are as follows:</td>
</tr>
<tr>
<td></td>
<td>• power off</td>
</tr>
<tr>
<td></td>
<td>• power reset</td>
</tr>
<tr>
<td></td>
<td>• power on</td>
</tr>
</tbody>
</table>

**Security-Enhanced Linux (SELinux) configuration on RHEL platforms**

You can configure SELinux on an Integrity MC990 X system computer that runs the RHEL operating system. SELinux supports Multi-Level Security (MLS) and Multi-Category Security (MCS) modes. When you configure SELinux, you create an MLS-compliant or MCS-compliant environment on an Integrity MC990 X system, and you enable MPI programs to take full advantage of all the features that Accelerate provides on MC990 X hardware. For more information about SELinux, see your RHEL documentation.

**NOTE:**

If you are not interested in MLS or MCS, you do not need to configure SELinux. In this case, do not perform the procedure in this topic.

The SLES operating system does not support SELinux.
To obtain help output for the `hpe-selinux-configuration` command, type the command name, with no options. For example:

```bash
# hpe-selinux-configuration
hpe-selinux-configuration
Actions
   -h|--help   Print usage
   -s|--status  Return module(s) status
   -i|--insert  Insert policy module
   -r|--remove  Remove policy module
   -l|--label  Label policy files
   -R|--restart Restart services affected by HPE policies
Select target policy modules (default is all)
   -S|--services Perform operation on services
   -D|--devices Perform operation on devices
       --bigpage
       --gru
       --mmtimer
       --xpmem
       --procset
       --arraysvcs
```

### Configuring Security-Enhanced Linux (SELinux) on RHEL platforms

**Procedure**

1. Log in as root.

2. Type the following commands to load the SELinux software modules from the RHEL distribution:

   ```bash
   # yum install policycoreutils-python
   # yum install selinux-policy-mls
   hpe_bigpage   1.0.0
   hpe_gru       1.0.0
   hpe_mmtimer   1.0.0
   hpe_xpmem     1.0.0
   hpe_procset   1.0.0
   hpe_arraysvcs 1.0.0
   ```

3. Type the following command to ensure that the modules are loaded correctly:

   ```bash
   # hpe-selinux-configuration -s
   ```

   If the SELinux software modules are loaded correctly, the command returns a list of the loaded modules.

   If the `hpe-selinux-configuration -s` command returns nothing, then the policy modules did not load correctly. Type the following command to load all HPE policies:

   ```bash
   # hpe-selinux-configuration -i
   ```

4. Type the following command to apply security labels to the file system for all kernel modules and services:

   ```bash
   # hpe-selinux-configuration -l
   ```

   Note that the option to the preceding command is a lowercase L character.

5. Type the following command to restart services:
# hpe-selinux-configuration -R

6. Perform the steps in this procedure again on all other partitions if your Integrity MC990 X system computer is divided into partitions.

### Installation of debuginfo packages

Operating system vendors provide debuginfo packages for each released version. After you install the debuginfo packages, you can debug crash kernels and use other advanced debugging techniques.

### Installing debuginfo packages on RHEL platforms

**NOTE:** For general information about RHEL debuginfo, see [https://access.redhat.com/solutions/9907](https://access.redhat.com/solutions/9907).

The examples in this procedure have been modified to fit in this documentation.

**Procedure**

1. **Subscribe to the appropriate debuginfo channel.**
   
   This channel differs, depending on your platform, as follows:
   
   - For RHEL 7.1, the channel is **Red Hat Enterprise Linux Server Debuginfo (v. 7)**
   
   
   - For RHEL 6.x, the channel is **Red Hat Enterprise Linux Server Debuginfo (v. 6)**
   

2. **To retrieve the list of repositories, enter the following command.**

   ```bash
   # yum repolist
   Loaded plugins: langpacks, product-id, subscription-manager
   This system is not registered to Red Hat Subscription Management.
   You can use subscription-manager to register.
   repo id               repo name              status
   !HPE-Foundation-Software       HPE-Foundation-Software         52
   !HPE-Foundation-Software-2.14    HPE-Foundation-Software-2.14       52
   !base                RHEL7 -               4,305
   !nightly-hpe-noship         hpe-noship               308
   !rh7-nightly      rh7-nightly              5,224
   !rh7.1                rh7.1                 4,371
   !rh7.1-debug         rh7.1-debug              4,194
   !rh7.1-source        rh7.1-source               0
   !rheil7-update       RHEL7-updates -           4,390
   repolist: 23,105
   ```

3. **To search for the debuginfo packages, enter the following command.**

   ```bash
   # yum search tar-debuginfo
   Loaded plugins: langpacks, product-id, subscription-manager
   This system is not registered to Red Hat Subscription Management.
   You can use subscription-manager to register.
   No results found.
   ```

46  Additional software features for the Integrity MC990 X system
To install the debuginfo packages, enter the following command.

```
# yum install tar-debuginfo.x86_64
```

Installing debuginfo packages on SLES platforms

**NOTE:** The examples in this procedure have been modified to fit in this documentation.

**Procedure**

1. Subscribe to the appropriate debuginfo channel.

   This channel differs, depending on your platform, as follows:
• For SLES 12 debuginfo information, see the following:
• For SLES 11 SPx debuginfo information, see the following:

2. To retrieve the list of repositories, enter the following command.

```
# zypper lr
```

<table>
<thead>
<tr>
<th>#</th>
<th>Alias</th>
<th>Name</th>
<th>Enabled</th>
<th>Refresh</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HPE-Foundation-Software-2.14</td>
<td>HPE-Foundation-Software-2.14</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>2</td>
<td>HPE-noship-stout712</td>
<td>HPE-noship-stout712</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>3</td>
<td>SLES12-12-0</td>
<td>SLES12-12-0</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>4</td>
<td>SLES12-Debuginfo-Pool</td>
<td>SLES12-Debuginfo-Pool</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>5</td>
<td>SLES12-Debuginfo-Updates</td>
<td>SLES12-Debuginfo-Updates</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>6</td>
<td>SLES12-SDK-Updates</td>
<td>SLES12-SDK-Updates</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>7</td>
<td>SLES12-Updates</td>
<td>SLES12-Updates</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>8</td>
<td>SUSE-Linux-Enterprise-SDK-12-DVD1</td>
<td>SUSE-Linux-Enterprise-SDK-12-DVD1</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>9</td>
<td>SUSE-Linux-Enterprise-SDK-12-DVD2</td>
<td>SUSE-Linux-Enterprise-SDK-12-DVD2</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>10</td>
<td>SUSE-Linux-Enterprise-SDK-12-DVD3</td>
<td>SUSE-Linux-Enterprise-SDK-12-DVD3</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>11</td>
<td>SUSE-Linux-Enterprise-Server-12-DVD1</td>
<td>SUSE-Linux-Enterprise-Server-12-DVD1</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>12</td>
<td>SUSE-Linux-Enterprise-Server-12-DVD2</td>
<td>SUSE-Linux-Enterprise-Server-12-DVD2</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>13</td>
<td>SUSE-Linux-Enterprise-Server-12-DVD3</td>
<td>SUSE-Linux-Enterprise-Server-12-DVD3</td>
<td>Yes</td>
<td>No</td>
</tr>
</tbody>
</table>

3. To search for the debuginfo packages, enter the following command.

```
# zypper search tar*debuginfo Loading repository data...
Reading installed packages...
```

<table>
<thead>
<tr>
<th>S</th>
<th>Name</th>
<th>Summary</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>tar-debuginfo</td>
<td>Debug information for package tar</td>
<td>package</td>
</tr>
</tbody>
</table>

4. To install the debuginfo packages, enter the following command.

```
# zypper install tar-debuginfo
Loading repository data...
Reading installed packages...
Resolving package dependencies...

The following NEW package is going to be installed:
  tar-debuginfo

1 new package to install.
Overall download size: 339.4 KiB. Already cached: 0 B
After the operation, additional 1.2 MiB will be used.
Continue? [y/n/? shows all options] (y): y
Retrieving package tar-debuginfo-1.27.1-2.22.x86_64
  (1/1), 339.4 KiB (1.2 MiB unpacked)
Checking for file conflicts: ..............................................
[done]
(1/1) Installing: tar-debuginfo-1.27.1-2.22 ...............................
[done]
Creating boot options

**NOTE:** HPE supports your ability to install more than one operating system, or operating system release level, on an Integrity MC990 X system. This procedure explains how to create options for non-default operating system boots so you can boot any operating system.

**Procedure**

1. Use the procedure shown in the **Figure 4: File Explorer screen** on page 50 to establish a connection to the RMC and log in.

2. Type the `uvcon` command.
   
   The `uvcon` command opens a console, and you need the console open in order to see the shell prompt.

3. Monitor the power-on process.
   
   The power-on takes only a few minutes, but it can take 5 to 10 minutes for the `uvcon` command to return boot-to-shell progress information.

4. After the power-on process completes, type `CTRL+-+]+q` to exit the console.
   
   **NOTE:** The `CTRL+-+]+q` key sequence closes the `uvcon` console session.

5. When the `Shell>` prompt appears, enter `exit` to access the BIOS manager.

6. Use the arrow keys to select `Boot Maintenance Manager`, and press `Enter`.

7. On the `Boot Maintenance Manager` screen, use the arrow keys to select `Boot Options`, and press `Enter`.

8. On the `Boot Options` screen, use the arrow keys to select `Add Boot Option`, and press `Enter`.

9. On the `File Explorer` screen, complete the following steps:
   
   a. Use the arrow keys to select the disk from which you want to boot, and press `Enter`.

   For example:
b. Peruse the directory system, from the disk you selected, through <efi> or <hpe>, through <redhat> or SUSE, until you find grub.efi (RHEL) or elilo.efi (SLES).

c. Select grub.efi (RHEL 7), elilo.efi (SLES 11), or grubx64.efi (RHEL 7 or SLES 12).

10. On the Modify Boot Option Description screen, note that the cursor is at the end of the Input the description field.

Complete the following steps:

a. Press Enter.

b. In the Please type in your data popup, enter a name for this boot option, and press Enter. For example, RHEL 6.6 or SLES11 SP3.

c. Use the arrow keys to select Commit Changes and Exit.

d. Press Enter.

11. On the Boot Maintenance Manager screen, select Boot Options, and press Enter.

12. On the Boot Options screen, use the arrow keys to select Change Boot Order, and press Enter.

13. On the Change Boot Order screen, complete the following steps:

a. If they are not already selected, select the boot order entries.

For example:
b. Press Enter.

c. On the popup that appears, select the boot option you created earlier in this procedure.

d. Press the + key to move the recently created boot option to the top of the list.

e. Press Enter to commit the changes in this step.

f. Select Commit Changes and Exit.

14. Press the Space bar to return to the BIOS manager.

15. Notify all system administrators of the current boot order.

HPE supports the ability to change the default boot order, but some system administration tasks might assume that the default boot option is still EFI Internal Shell. You might need to change the boot order in order to access the EFI shell in the process of performing other tasks that this chapter describes. If you need to change the boot order, complete this procedure again and select one of the other boot options.

Crash dump files on an Integrity MC990 X system server on RHEL 7, SLES 12, and SLES 11 platforms

You can request that the operating system write a crash dump file. The file name includes a timestamp, and the file location depends on your operating system, as follows:

- For the RHEL 7 operating system, the file is as follows:

  `/var/crash/127.0.0.1-year.month.day-hour:minutes:seconds`

- For SLES 11 and SLES 12 operating systems, the file is as follows:
NOTE:
This topic does not apply to RHEL 6 platforms. The `power nmi` and `power diag` commands send back traces of CPU tasks to the console but do not create a crash dump file.

Creating a crash dump file on an Integrity MC990 X system server on RHEL 7, SLES 12, and SLES 11 platforms

Procedure

1. Log in to the MC990 X server as the root user, and enter the following commands to enable the kernel crash dump service, `kdump`:

   On RHEL 7 and SLES 12, enter the following:
   ```
   # systemctl enable kdump
   # systemctl start kdump
   ```

   On SLES 11, enter the following:
   ```
   # chkconfig boot.kdump on
   # service boot.kdump start
   ```

   The Foundation Software package installation process enables `kdump` by default. If you are unsure of whether `kdump` is enabled on your MC990 X server, enter the preceding commands. You can enable `kdump` on your server at any time. `kdump` must be enabled to create a crash dump file.

2. (Conditional) Ensure that the `uv_nmi` default action is `kdump`.

   Complete this step on RHEL 7 and SLES 12 platforms.

   Enter the following command:
   ```
   # echo kdump > /sys/module/uv_nmi/parameters/action
   ```

   As an alternative to this command, you could also boot the kernel with the following parameter:
   ```
   uv_nmi.action=kdump
   ```

3. Send a nonmaskable interrupt (NMI) signal to start the dump.

   You can either send an NMI from a remote connection or when logged in directly to the RMC, as follows:

   - To send the NMI signal from a remote connection, enter the following `ipmitool` command:
     ```
     # ipmitool -I lanplus -H uv1-rmc -U ADMIN -P ADMIN chassis power diag
     ```

   - To send the NMI signal while logged in directly to the RMC, complete the following command sequence:
     a. To connect securely, enter the `ssh` command. For example:
# ssh root@uv1-rmc

Provide the root user password when prompted. For more information about connecting to the RMC, see the following:

**Figure 4: File Explorer screen** on page 50

**b.** To send the NMI signal, enter the following command.

```
RMC> power nmi
```

4. (Conditional) Open a console to the RMC and to initiate a crash dump capture.

Complete this step on SLES 11 platforms.

Enter the following commands:

```
> uvcon
kdb> kdump
```

On SLES 11 platforms, you can enter additional kdb commands at the kdb> prompt. For information about kdb commands, see your SLES documentation.
Connecting to an MC990 X system through a web browser and launching the JViewer console

About JViewer

JViewer is a software interface that you can use on HPE MC990 X systems. The JViewer graphical user interface can facilitate installation and booting.

Starting JViewer

Procedure

1. Verify that you have Java and an internet browser (Firefox preferred) installed on your local computer.

2. Attach the Base I/O BMC on the MC990 X system to a network that you can access from the local computer.

   **NOTE:** Use the RJ45 connection labeled **MGMT** on the BMC on which the Base I/O is installed.

3. Log in to the MC990 X system’s RMC.
   For example:
   ```bash
   ssh root@uv-rmc
   ```
   Provide the password when prompted.

4. Use the `baseiolist` command to retrieve the IP address(es) of the MC990 X system’s BMC(s).
   For example:
   ```bash
   # baseiolist
   P000 [r001i01b]: 128.162.243.151 [08:00:69:17:2D:C9]
   P000 [r001i06b]: <No IP addr> [08:00:69:17:2D:C0]
   ```
   Look for the BMC’s IP address in the output. In this example, there is only one BMC connected to the network, and its IP address is 128.162.243.151.

5. Start the internet browser on your local computer.

6. In the Firefox address bar, type the IP address of the BMC.
   For example:
   ```bash
   http://128.162.243.151
   ```

7. From the login screen, log in to the system.
   Type `admin` as the username and the password, and then press **Enter**.

8. From the **Dashboard** screen, click **Launch**.

9. (Conditional) If Firefox displays a message indicating pop ups are not enabled, complete the following steps to enable pop ups.
a. Click Preferences.
b. Click Allow pop ups for ip_address.
c. Click Launch.

10. On the Opening jviewer.jnlp ... screen, click OK.
11. (Conditional) Consent to the security questions.
   If the system displays security cautions, indicate that you want to proceed with launching the application.

Attaching virtual media to the MC990 X system

Procedure

1. Connect to the MC990 X system. See Starting JViewer on page
2. In the top-most JViewer menu bar, click Media > Virtual Media Wizard ...
3. Access the media.
   a. To use physical media, such as a DVD or CD, insert the disk into the drive on your local computer. On the Virtual Media pop up, under CD/DVD Media 1, select /dev/sr0.
   b. To access an ISO on your network, click Browse on the popup, and navigate to the ISO location. Select the ISO file, and click Open.
4. Click Connect to CD/DVD.
5. On the Information pop up, click OK.
6. On the Virtual Media pop up, click Close.
7. (Optional) Boot the system. See Booting from virtual media on page 55

Booting from virtual media

Procedure

1. Log in to the MC990 X system RMC and provide the password when prompted.
   For example:
   
   ssh root@uv-rmc
2. Enter the uvcon command to access the console.
3. (Conditional) Access the main EFI menu. Complete this step if you are at the EFI shell:
   Type exit and press Enter.
4. Use the arrow keys to select Boot Manager, and press Enter.
5. On the Boot Manager screen, use the down-arrow key to select or highlight UEFI American Megatrends Inc. Virtual Cdrom Device, and press Enter.
Websites

HPE MC990 X Server websites
MC990 X Server product page
    www.hpe.com/support/mc990x-product
MC990 X Server customer documentation
    www.hpe.com/support/mc990x-docs
MC990 X Server software
    www.hpe.com/support/mc990x-software
MC990 X Server QuickSpecs
    www.hpe.com/support/mc990x-quickspecs
MC990 X Server Spare Parts
    www.hpe.com/support/mc990x-spareparts
MC990 X Server Option Parts
    www.hpe.com/support/mc990x-optionparts

Configuring SAN Boot on HPE Integrity MC990 X

MC990 X Server support documentation
To access restricted support documentation for HPE MC990 X Server:
    https://support.hpe.com/hpsc/public/home/signin
2. Go to the restricted MC990 X Server page.
    www.hpe.com/support/mc990x-docs-restricted

General websites
Hewlett Packard Enterprise Information Library
    www.hpe.com/info/EIL
Single Point of Connectivity Knowledge (SPOCK) Storage compatibility matrix
    www.hpe.com/storage/spock
Storage white papers and analyst reports
    www.hpe.com/storage/whitepapers
For additional websites, see Support and other resources.
Support and other resources

Accessing Hewlett Packard Enterprise Support

- For live assistance, go to the Contact Hewlett Packard Enterprise Worldwide website:
  http://www.hpe.com/info/assistance
- To access documentation and support services, go to the Hewlett Packard Enterprise Support Center website:
  http://www.hpe.com/support/hpescc

Information to collect

- Technical support registration number (if applicable)
- Product name, model or version, and serial number
- Operating system name and version
- Firmware version
- Error messages
- Product-specific reports and logs
- Add-on products or components
- Third-party products or components

Accessing updates

- Some software products provide a mechanism for accessing software updates through the product interface. Review your product documentation to identify the recommended software update method.

- To download product updates:
  Hewlett Packard Enterprise Support Center
  www.hpe.com/support/hpescc
  Hewlett Packard Enterprise Support Center: Software downloads
  www.hpe.com/support/downloads
  Software Depot
  www.hpe.com/support/softwaredepot
- To subscribe to eNewsletters and alerts:
  www.hpe.com/support/e-updates
- To view and update your entitlements, and to link your contracts and warranties with your profile, go to the Hewlett Packard Enterprise Support Center More Information on Access to Support Materials page:
  www.hpe.com/support/AccessToSupportMaterials

**IMPORTANT:** Access to some updates might require product entitlement when accessed through the Hewlett Packard Enterprise Support Center. You must have an HPE Passport set up with relevant entitlements.
Customer self repair

Hewlett Packard Enterprise customer self repair (CSR) programs allow you to repair your product. If a CSR part needs to be replaced, it will be shipped directly to you so that you can install it at your convenience. Some parts do not qualify for CSR. Your Hewlett Packard Enterprise authorized service provider will determine whether a repair can be accomplished by CSR.

For more information about CSR, contact your local service provider or go to the CSR website:
http://www.hpe.com/support/selfrepair

Remote support

Remote support is available with supported devices as part of your warranty or contractual support agreement. It provides intelligent event diagnosis, and automatic, secure submission of hardware event notifications to Hewlett Packard Enterprise, which will initiate a fast and accurate resolution based on your product's service level. Hewlett Packard Enterprise strongly recommends that you register your device for remote support.

If your product includes additional remote support details, use search to locate that information.

Remote support and Proactive Care information
HPE SGI Remote Support Release Notes
www.hpe.com/support/axeda-release-notes
HPE Proactive Care services
www.hpe.com/services/proactivecare
HPE Proactive Care service: Supported products list
www.hpe.com/services/proactivecaresupportedproducts
HPE Proactive Care advanced service: Supported products list
www.hpe.com/services/proactivecareadvancedsupportedproducts

Proactive Care customer information
Proactive Care central
www.hpe.com/services/proactivecarecentral
Proactive Care service activation
www.hpe.com/services/proactivecarecentralgetstarted

Warranty information

To view the warranty information for your product, see the links provided below:
HPE ProLiant and IA-32 Servers and Options
www.hpe.com/support/ProLiantServers-Warranties
HPE Enterprise and Cloudline Servers
www.hpe.com/support/EnterpriseServers-Warranties
HPE Storage Products
www.hpe.com/support/Storage-Warranties
HPE Networking Products
www.hpe.com/support/Networking-Warranties

Regulatory information

To view the regulatory information for your product, view the Safety and Compliance Information for Server, Storage, Power, Networking, and Rack Products, available at the Hewlett Packard Enterprise Support Center:
www.hpe.com/support/Safety-Compliance-EnterpriseProducts
Additional regulatory information

Hewlett Packard Enterprise is committed to providing our customers with information about the chemical substances in our products as needed to comply with legal requirements such as REACH (Regulation EC No 1907/2006 of the European Parliament and the Council). A chemical information report for this product can be found at:

www.hpe.com/info/reach

For Hewlett Packard Enterprise product environmental and safety information and compliance data, including RoHS and REACH, see:

www.hpe.com/info/ecodata

For Hewlett Packard Enterprise environmental information, including company programs, product recycling, and energy efficiency, see:

www.hpe.com/info/environment

Documentation feedback

Hewlett Packard Enterprise is committed to providing documentation that meets your needs. To help us improve the documentation, send any errors, suggestions, or comments to Documentation Feedback (docsfeedback@hpe.com). When submitting your feedback, include the document title, part number, edition, and publication date located on the front cover of the document. For online help content, include the product name, product version, help edition, and publication date located on the legal notices page.